
STUDY OF SIKKIM HIMALAYAN GLACIERS USING 

SATELLITE DATA ON ARC GIS 

               A DISSERTATION SUBMITTED IN PARTIAL FULFILLMENT OF THE REQUIREMENTS 

FOR THE AWARD OF THE DEGREE 

OF 

MASTER OF TECHNOLOGY 

IN 

ENVIRONMENTAL ENGINEERING 

Submitted by: 

Ankit Yaduvansi 

(2K16/ENE/03) 

Under the supervision of 

Dr. ANUBHA MANDAL 

(PROFESSOR AND UGC SCIENTIST) 

& 

Dr. ANUBHA AGRAWAL 

 (POST-DOCTORAL FELLOW) 

 

DEPARTMENT OF ENVIRONMENTAL ENGINEERING 

DELHI TECHNOLOGICAL UNIVERSITY 

(FOMERLY DELHI COLLEGE OF ENGINEERING) 

BAWANA ROAD, DELHI-110042 

  JULY, 2018 



DELHI TECHNOLOGICAL UNIVERSITY 

(FORMERLY DELHI COLLEGE OF ENGINEERING) 

BAWANA ROAD, DELHI-110042 

 

                                  CANDIDATE’s DECLARATION 

 

I, ANKIT YADUVANSI, 2K16/ENE/03, student of M.Tech (ENVIRONMENT 

ENGINEERING), hereby declare that the project Dissertation titled “STUDY OF SIKKIM 

HIMALAYAN GLACIERS USING SATELLITE DATA ON ARC GIS” which is submitted by 

me to the Department of Environmental Engineering, Delhi Technological University, Delhi in 

partial fulfilment of the requirement for the award of the degree of Master of Technology, is 

original and not copied from any source without proper citation. This work has not previously 

formed the basis for the award of any Degree, Diploma Associate ship, Fellowship or other 

similar title or recognition. 

 

 

 

 

 

 

Place: Delhi  

Date:                                                                                                  (ANKIT YADUVANSI)  

 

 

 

 



DELHI TECHNOLOGICAL UNIVERSITY 

(FORMERLY DELHI COLLEGE OF ENGINEERING) 

BAWANA ROAD, DELHI-110042 

 

CERTIFICATE 

 

I hereby certify that the Project Dissertation titled “STUDY OF SIKKIM HIMALAYAN 

GLACIERS USING SATELLITE DATA ON ARC GIS” which is submitted by ANKIT 

YADUVANSI, 2K16/ENE/03, Department of Environmental Engineering, Delhi Technological 

University, Delhi in partial fulfilment of the requirement for the award of the degree of Master of 

Technology, is a record of the project work carried out by the students under my supervision. To 

the best of my knowledge this work has not been submitted in part or full for any Degree or 

Diploma to this University or elsewhere.   

 

                                                                                          

Dr. ANUBHA MANDAL                       

                                                                                                                                       SUPERVISOR 

 

                                                                                  

                                                                                 

                                                                              Dr. ANUBHA AGARWAL  

                                                                                                                                   CO-SUPERVISOR 

 

 



Page | 1  
 

ACKNOWLEDGEMENT 

 

To begin with, first and foremost I will thank almighty GOD for showering his divine 

blessing upon me and helping me wherever needed, as my parents, guide, teachers, etc. and 

finally enabling me to achieve this long-awaited professional height of my academic career.  

 I would like to express my sincere gratitude for my esteemed teacher and guide Dr. Anubha 

Mandal, Department of Environmental Engineering, Delhi Technological University, Delhi 

whose painstaking guidance, generous help, stimulating comments, constructive criticism and 

sound suggestions enabled me to bring this work to its present form. 

I am highly thankful to my co-guide Dr. Anubha Agarwal for sharing her personal research 

experiences and providing the necessary constructive criticism which has helped me in 

deriving the best result from my study. 

I am also thankful to professor S.K Singh Head of Department of Environmental 

Engineering, Delhi Technological University, Delhi for his elderly patronage, encouragement 

and providing me the best available facilities during the course of this study. 

I am highly indebted to my parents and other family members who have always showered 

their blessings and affection during this research period. 

 

 

 

 

 

 

                                                                                                                                               ANKIT YADUVANSI 

 

 

 

 

 



Page | 2  
 

CONTENTS 

TOPIC                                                                                                                       Pg.NO. 

Acknowledgement                                                                                                            1 

Table of contents                                                                                                                2 

List of Figures                                                                                                                 4 

List of Tables                                                                                                                   6 

List of Abbreviations used                                                                                                7 

1. Introduction                                                                                                                    8 

2. Review of Literature                                                                                                 11                                                                          

2.1 History of glaciation.                                                                                                 11 

2.2 Importance of glaciation.                                                                                           13 

2.3 Glacial retreat.                                                                                                          14 

2.4 Methods used for glacier studies.                                                                                16 

3. Study area                                                                                                                  19 

3.1 Introduction                                                                                                              19 

3.2 Climate                                                                                                                       20 

3.3 Geomorphology and geology                                                                                        21 

3.4 Natural resources                                                                                                           22 

     3.4.1 Forest resources                                                                                                        22 

     3.4.2 Farming                                                                                                                   22 

     3.4.3 Hydropower and mineral resources                                                                            23 

3.5 Demographic features and Economic Profile                                                               23 

     3.5.1 Demographic features                                                                                             23 

     3.5.2 Economic profile                                                                                                  23 

4. Data sources                                                                                                                24 

4.1 Landsat 7                                                                                                                  24 

4.2 Landsat 8                                                                                                                 26 

4.3 Diva GIS                                                                                                                      28 

4.4 Temperature and Precipitation data from Indian Meteorological Department                 28 



Page | 3  
 

5. Methodology                                                                                                                       29 

5.1 Analysis of satellite data                                                                                             29 

     5.1.1 Data Collection                                                                                                  29 

     5.1.2 Adding data in Arc Map                                                                                     30 

     5.1.3 Creating False Colour Composite                                                                           31 

             5.1.3.1 Steps performed for creating False Colour Composite                                32 

     5.1.4 Band Ratio Methods                                                                                         33 

             5.1.4.1 Steps performed for making band ratio                                                          33 

     5.1.5 Finding the threshold for ice and snow                                                                34 

             5.1.5.1 Steps performed for finding threshold                                                           34 

     5.1.6 Image Filtering                                                                                                  35 

             5.1.6.1 Steps performed image filtration                                                             36 

     5.1.7 Raster to vector conversion                                                                                36 

             5.1.7.1 Steps performed for vector conversion                                                     36 

     5.1.8 Extraction                                                                                                        37 

             5.1.8.1 Steps performed for extraction                                                                38 

     5.1.9 Area calculations                                                                                              39 

                 5.1.9.1 Steps performed for area calculation                                                        39 

5.2 Analysis of meteorological data                                                                                40 

     5.2.1 Steps performed for temperature and rainfall analysis                                          41 

             5.2.1.1 Temperature analysis                                                                              41 

              5.2.1.2 Rainfall analysis                                                                                     48 

6. Results and Discussions                                                                                              55 

7. Conclusion                                                                                                               56 

 

 

 

 



Page | 4  
 

LIST OF FIGURES 

Figure No.                                                                                                                   Pg. No. 

3.1 Location map of Sikkim and two sub basins                                                                   19 

5.1 Greyscale image of downloaded data from USGS                                                          30 

5.2 FCC of Sikkim of year 2005                                                                                      32 

5.3 Band ratio image of Sikkim of year 2005                                                                    34 

5.4 Threshold image of Sikkim of year 2016                                                                     35 

5.5 Raster converted to polygons of year 2005                                                                  37 

5.6 Extraction mask of Sikkim region                                                                               39 

5.7 Temperature variation graph for January from 1966-2000                                             41 

5.8 Temperature variation graph for February from 1966-2000                                           42 

5.9 Temperature variation graph for March 1966-2000                                                      42 

5.10 Temperature variation graph for April from 1966-2000                                              43 

5.11 Temperature variation graph for May from 1966-2000                                              43 

5.12 Temperature variation graph for June from 1966-2000                                                44 

5.13 Temperature variation graph for July from 1966-2000                                                 44 

5.14 Temperature variation graph for August from 1966-2000                                              45 

5.15 Temperature variation graph for September from 1966-2000                                       45 

5.16 Temperature variation graph for October from 1966-2000                                             46 

5.17 Temperature variation graph for November from 1966-2000                                       46 

5.18 Temperature variation graph for December from 1966-2000                                          47 

5.19 Annual average temperature variation graph from 1966-2000                                      47 

5.20 Rainfall variation graph for January from 1966-2000                                                      48 

5.21 Rainfall variation graph for February from 1966-2000                                               48 

5.22 Rainfall variation graph for March from 1966-2000                                                   49 

5.23 Rainfall variation graph for April from 1966-2000                                                    49 

5.24 Rainfall variation graph for May from 1966-2000                                                     50 



Page | 5  
 

5.25 Rainfall variation graph for June from 1966-2000                                                        50 

5.26 Rainfall variation graph for July from 1966-2000                                                        51 

5.27 Rainfall variation graph for August from 1966-2000                                                      51 

5.28 Rainfall variation graph for September from 1966-2000                                             52 

5.29 Rainfall variation graph for October from 1966-2000                                                   52 

5.30 Rainfall variation graph for November from 1966-2000                                              53 

5.31 Rainfall variation graph for December from 1966-2000                                              53 

5.32 Annual average rainfall variation graph from 1966-2000                                                54 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page | 6  
 

 

LIST OF TABLES 

Table No.                                                                                                                  Pg. No. 

4.1 Landsat 7 band properties                                                                                              26 

4.2 Landsat 8 band properties                                                                                            27 

6.1 Glacial area every year                                                                                                 55 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Page | 7  
 

LIST OF ABBREVATIONS USED 

ASTER          Advanced Spaceborne Thermal Emission and Reflection Radiometer 

DEM             Digital Elevation Model 

DN                Digital Number 

ELA              Equilibrium Line Altitude 

ETM             Enhanced Thematic Mapper 

FCC              False Colour Composite 

GIS               Geographical Information System 

GSI               Geological Survey of India 

IR                  Infrared 

IMD              Indian Meteorological Department 

IPCC             Intergovernmental Panel on Climate Change 

MoEF           Ministry of Environment and Forest 

MSS             Multi-Spectral Scanner 

NASA          National Aeronautics and Space Administration 

NDSI             Normalized-Difference Snow Index 

NIR              Near Infrared 

NDC              National Data Centre 

OLI               Operational Land Imager 

SWIR           Short Wave Infrared 

TIRS            Thermal Infrared Sensor 

TM                Thematic Mapper 

USGS           United States Geological Survey 

 

 

 

 



Page | 8  
 

CHAPTER 1 

INTRODUCTION 

Snow is an important part of the cryosphere, and the study on snow trends is essential to 

understand regional climate change and managing water resources. Detailed information 

about snow cover in space and time is must to assess water discharge, understanding and 

mitigating snow disasters, and analysing climate change. In the cryosphere, snow is the 

component that changes most promptly with the seasons. Due to the feedback effects these 

changes occur and their impact are seen on surface energy and atmospheric processes. Thus, 

snow is an important focus for research into climate change and adaptation. Permanent snow 

fields and glaciers located in high altitudes of Himalayan mountain chains are very important 

natural resources of frozen fresh water for India‟s development, planning and growth. 

Glaciers are formed due to recrystallization and metamorphism of naturally fallen snow on 

land surface. It is permanent snow cover which gives rise to formation of glaciers. Glaciers 

are formed when rate of gathering of snow is more than rate of ablation and dropping snow 

gets enough time and space to get metamorphosed to form ice.  Sometimes glacier is also 

referred as movement of glacier ice under the impact of gravity. The glaciers are mass of 

snow, ice, and water and rock remains slowly moving down a slope. Out of these ice is an 

essential component. Presently, ice is distributed either in Polar Regions earth or in high 

mountainous regions. 

Two parts of the glaciers are: gathering zone and ablation zone parted by snow line. In the 

gathering zone the total accumulation from winter snowfall is more than the summer ablation. 

In ablation zone, total summer melting is more than the winter snow accumulation. Debris 

cover on the ablation zone of glaciers is ubiquitous throughout the Himalaya. As a 

consequence, the production of meltwater decreases, instead of increasing, with the decrease 

in elevation. 

Therefore, glacier ice along with rock remains (debris) gets exposed on the surface during 

summer. The frontal most part of ablation zone of the glacier from where river or stream 

appears on the surface is its terminus or snout. 

 In the Himalayas, glaciers cover an area of approximately 33000 km
2
, and this is one of the 

largest concentrations of glacier-stored water outside the Polar Regions. Melt-water from 

these glaciers forms an important source of the run-off of North Indian rivers during the 
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critical summer months. This makes these rivers perennial and has helped to sustain and 

flourish the civilizations along the banks of the Indus, Ganga and Brahmaputra. This supply 

of melt-water is available during dry periods and naturally regulates the flow of large rivers 

thus compensating for extremes of precipitation. Glacial activity also generates sediments. 

However, there has been evidence in recent geological history about glacier mass fluctuations 

resulting in stream runoff originating from them. Stream runoff is an important component in 

the planning of water resources and micro and mini hydroelectric projects. Glacier mass 

fluctuations are also indicators of global climatic changes. In the context of the Himalayan 

glaciers which are the source of many giant north Indian rivers, the systematic monitoring of 

Himalayan glaciers is of paramount importance in view of their large number and area 

covered. 

The distribution of glaciers as what we see today is the result of last glaciation. Glaciation 

and deglaciation are the alternate cycles of cold and warm climate of earth. During 

Pleistocene, the earth's surface had experienced repeated glaciations over a large land mass. 

The most recent glaciations reached its maximum advance about 20,000 years ago due to fall 

of temperatures by 5º to 8º C. A Little ice age has been also recognized during 1650-1850 

AD.  During peak of glaciations approximately 47 million km area was covered by glaciers, 

three times more than the present ice cover of the earth. Based upon morphological 

characteristics of  glaciers, The glaciers can be grouped into classes such as ice sheet, ice cap, 

and glacier constrained by topography. Ice sheet and ice cap are formed when underlying 

topography is fully submerged by ice and glacier flow is not influenced by topography. On 

the other hand, when glaciers are constrained by the surrounding topography and the shape of 

valley influences their flow, then such glaciers are classified as valley glaciers, cirque 

glaciers and ice fields. Himalayan glaciers are focus of public and scientific debate because 

of its highest concentration of snow and glaciers outside polar region. Nearly, 800 million 

people live in the catchments of the Indus, Ganges, and Brahmaputra rivers and rely to 

varying extents. 

Glaciers are the most visible indicator of climatic change and are the store houses of fresh 

water as well as hydropower energy. The study of glaciers is important to understand climate 

change and the societal impacts of glacier response to climate change in terms of water 

resource management. In the past few decades, global climate change has had a significant 

impact on the high mountain environment: snow, glaciers and permafrost are especially 

sensitive to changes in atmospheric conditions because of their proximity to melting 
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conditions. In fact, changes in ice occurrences and corresponding impacts on physical high-

mountain systems could be among the most directly visible signals of global warming. 

Seventy per cent of the world‟s freshwater is frozen in glaciers. Glacier melt buffers other 

ecosystems against climate variability. Many times it provides the only source of water for 

humans and biodiversity during dry seasons. Freshwater is already a limited resource for 

much of the planet, and in the next three decades, the population growth is likely to far 

exceed any potential increase in available water. The study of glaciers in India is very 

important both from scientific and economical perspectives. The Himalaya contains one of 

the largest reservoirs of snow and ice outside the Polar Regions. Glaciers are a major source 

of fresh water, and all the rivers in northern India are nourished by melt waters of the 

Himalaya glaciers, thereby affecting the quality of life of millions of people. The northern 

plains of India sustain on the perennial melt of snow and glaciers covering the water 

requirements of agriculture, industries, domestic sector. It is of supreme importance to assess 

the state of glaciers and to know the sustainability of glaciers in view of changing global 

scenarios of climate and water security of the nation. It is important to study the status of 

Himalayan glaciers to understand the trend of prevailing climate and to predict future 

scenarios. 

Glaciers are very vital to human kind as these natural resources are (i) reservoirs of 

freshwater (ii) control global climate as the albedo over snow and glaciers is very high, (iii) 

sensitive indicators of climatic variations. Since glaciers of Himalaya constitutes the largest 

concentration of freshwater reserve outside the polar region, a great significance is attached 

to the fact that these natural resources are the source of fresh water to almost all minor and 

major rivers of northern India and sustain the civilization for irrigation, hydroelectricity and 

drinking water. Concentration of glaciers in Himalaya varies from northwest to northeast 

according to the variation in altitude and latitude of the region. Siachin glacier in Kashmir, 

Gangotri glacier in Uttarakhand, Bara Shigri glacier in Himachal, Baltoro glacier in 

Karakoram and Zemu glacier in Sikkim are a few famous glaciers of Himalayas. The retreat 

or advance of glaciers of individual glaciers depends upon the variations in mass balance. 

The retreat depends upon static and dynamic factors. The static parameters are latitude, slope, 

orientation, width and size of the valley and altitude distribution of glaciers. The dynamic 

parameters are annual accumulation and ablation of snow and ice. These factors further 

depend upon daily and yearly variations in temperature, solid/liquid precipitation, heat flow 

from earth crust, debris cover and cloud cover. 
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Moraine cover, consists of dust, silts sands, gravel, cobbles and boulders. It is one of the most 

important components of a glacier system in view of the control it exercises on rate of glacier 

melting. Its areal cover and thickness should be known in order to estimate effect of climate 

on retreat of glaciers. Retreat of glaciers is one of the major issue for the world. Many studies 

are being conducted to analyse the change in the area and length of glaciers. Global warming 

is one of the major issue for melting of glaciers which have impact on the climate of world. 

Many unwanted climatic changes are taking place worldwide and having negative impact on 

the environment. Many global organisations are analysing the negative impacts due to change 

in the glaciers. These Himalayan glaciers feed seven of Asia‟s great rivers: the Ganga, Indus, 

Brahmaputra, Salween, Mekong, Yangtze and Huang Ho. It ensures a year round water 

supply to millions of people 

The Himalayas have the largest concentration of glaciers outside the polar caps.  Himalayan 

region of India is home of some of the most notable glaciers in the world. This is a list of the 

notable glaciers in India. Most glaciers lie in the states of Sikkim, Jammu and Kashmir, 

Himachal Pradesh and Uttarakhand. Few glaciers are also found in Arunachal Pradesh.  

Glaciers are found in all geographic areas of the Himalaya which lie above the elevation 

required to maintain ice. Glaciers having measurable length up to 10 kilometres in length are 

also  present in some areas . Such mountain areas in India are the Nun-Barashigri, Gangotri-

Chaukhamba, Kamet group, Nanda Devi group, and Kanchenjunga. The principal glaciers of 

the Indian Himalaya, including their lengths, are: Gangotri, Zemu (Sikkim Himalaya), Milam 

(Nanda Devi area) and Kedarnath (Gangotri-Chaukhamba area). 

Objective of the study is asses the area change of Sikkim Himalayan glaciers using automatic 

image analysis technique. 
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CHAPTER 2 

REVIEW OF LITRETURE 

2.1 History of Glaciation 

Studies begun in the 1970s embraced many aspects of snow and glacier phenomena and 

included glacier mass balance, the pattern of glacier movement, glacier recession/advance, 

meltwater discharge, ice thickness in glaciers, crystal fabrics of ice, the radiation balance of 

snow and ice surfaces, dating of ice by isotopic studies, detailed cartography of glaciers, the 

study of paleoglaciation, and compilation of glacier inventories. The studies are described by 

Tewari (1971) and Vohra (1981) and included in unpublished reports of GSI. 

 In the 1980s, the author estimated that about 15,000 glaciers occur in the Himalaya. 

Considered high, this estimate was based on the average size of glaciers derived from glacier 

inventories from parts of the Himalaya, and from von Wissman‟s (1959) estimate of total ice 

cover. More recent glacier inventory work by Qin (1999), however, determined that there 

were 18,065 glaciers in the five drainage basins of the Himalaya, covering 35,110 km
2
; this 

number was based on analysis of 1975–78 Landsat MSS band 7 and false-colour (bands 4, 5, 

7) images, as well as some aerial photographs. So the author‟s 1980s estimate was actually 

20% too low. 

During its geological history, the earth has experienced alternate cycles of warm and cold 

climates. During cold climates, glaciers and ice sheets formed on the surface of the earth. 

Geological evidence suggests that the earth had experienced glaciations during the Permo 

Carboniferous and in the Pleistocene period (Embleton and King, 1975). 

Precambrian tillites and boulder-beds are also reported from many parts of the world such as 

Scotland and the U.S.A. Clear evidence of the Permo Carboniferous ice age has also been 

established in India and South Africa. Permo-Carboniferous glaciation was followed by the 

Mesozoic era, during which the world temperature was higher than that of today and no 

evidence of glaciation was observed in the geological formations of that period.  In the 

Cenozoic era, large-scale glaciations were experienced including glaciation during the 

Pleistocene and Quaternary periods (Smith et al., 2005). 

Glaciation has also influenced the present distribution of glaciers on the earth's surface. 

During the Pleistocene period, the earth's surface experienced repeated glaciation over a large 
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land mass. During the peak of glaciation, the area covered by the glaciers was 46 Million km
2 

(Embleton and King, 1975). This was more than three times the present ice cover of the earth. 

A composite inventory of the glaciers of the Himalaya by Kaul (1999), based on a 

combination of detailed and regional assessments, yielded a total of only 5,243 glaciers 

covering an area of about 38,000 km
2
. Kaul (1999) also reported that about 8,500 km

2
 of the 

glaciers are located in the Indian Himalaya. There are 84 Glaciers in the Teesta basin and the 

East-Rathong Glacier is one of them (Glacier Atlas of Teesta Basins 2001).   

Himalayan glaciers have been grouped as clean-ice type (C-type) and debris-covered ice type 

(Basnett, Kulkarni, and Bolch 2013; Du et al. 2014; Pratap et al. 2015; Ke, Ding, and Song 

2015). Himalayan mountainous environment characterizes debris-covered glaciers or moraine 

glaciers, and thus, the study of glacier dynamics is important to describe their changing 

conditions and rate of melt at the present day (Marston, Fritz, and Nordberg 1997; Pratap et 

al. 2015; Janke, Bellisario, and Ferrando 2015; Earl and Gardner 2016). Many research 

studies have revealed that around 70–80% of Himalayan glaciers are debris-covered and have 

been retreating almost since the end of the Little Ice Age (Bhambri, Bolch, and Chaujar 2011; 

Bolch et al. 2012; Immerzeel, Pellicciotti, and Bierkens 2013; Way, Bell, and Barrand 2015; 

Earl and Gardner 2016). However, very few studies showed an increase in the glacier mass 

(Frey, Paul, and Strozzi 2012; Gardelle, Berthier, and Arnaud 2012). 

2.2 Importance of Glaciation 

The fundamental goal of glaciology is to infer climatic signals and understanding fluctuations 

in water regimes due to climatic variability. Glacier mass balance, snout movement and 

equilibrium line altitudes (ELA) are the most visible glacier parameters, which are directly or 

indirectly related to prevailing and/or past climate. Himalaya is the youngest and highest 

mountain chain of the world and is abode to many large and small glaciers, and so is known 

as the Water Tower of Asia (Immerzeel et al., 2010). 

It is important to study the status of Himalayan glaciers to understand the trend of prevailing 

climate and to predict future scenarios. The Himalayan region is fed by two major weather 

systems viz. the Indian Summer Monsoon (ISM) and the mid-latitude westerlies (Benn and 

Owen, 1998). The eastern part of Himalaya experiences substantial amount of summer 

precipitation from ISM which declines north westward. The mid-latitude westerlies brings 

winter precipitation maximum at the extreme west of the Himalaya, Trans Himalaya and 
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Tibet, as a consequence of moisture being advected from the Mediterranean, Black and 

Caspian Seas (Benn and Owen, 1998). 

The Intergovernmental Panel on Climate Change (IPCC) observed that the average 

temperature of the Earth increasingly suffers frequent annual high value. The global climatic 

heating describes not only this phenomenon but also the diminution of the snow 

precipitations, both factors that negatively influence the mass balance of a glacier. A glacier 

characterised by a negative mass balance is not in equilibrium and confirms a fast and 

dramatic withdrawal. This situation causes the disappearance of some glaciers of the world 

and puts others in danger, providing many repercussions on the availability of natural water 

resources for different purposes. In the future there could be many difficulties for the 

agriculture irrigation, for the domestic use and for the production of hydroelectric energy; for 

the local economies founded on the tourism climbing; for the ecosystems founded upon the 

break-up of the glaciers and, in a long-term perspective, the level of the oceans could rise    

(Maliniverni et al 2008). 

The Himalayan region has one of the largest concentrations of glaciers. Major rivers such as 

Indus, Ganga, Brahmaputra and their numerous tributaries originate from the glacier bound 

terrain. The contribution of glacier melt in annual stream runoff is substantially higher in 

Indus basin as compared to Ganga and Brahmaputra (Immerzeel et al., 2010, Singh and Jain 

2014). 

2.3 Glacial Retreat  

The retreat of the glacier from 1976 to 2009 is around 460 meters and during 12 year period 

from1997 to 2009, it was 234 m. The retreat of glacier was measured along the centreline. 

The investigations suggest that the glacier shows a retreating trend. The rate of retreat is 19.5 

m/year during the last 12 years. This rate of retreat is similar to like Himalayan glaciers in 

western Himalayas. The high retreat comprises a significant portion of the low flow of 

Himalayan Rivers as during the dry season snow and glaciers melt in the Himalayan region 

and feed the rivers. The runoff supplies communities with water for drinking, irrigation and 

industry, and is also vital for maintaining river and riparian habitat. It is possible that the 

accelerated melting of glaciers will cause an increase in river levels over the next few 

decades, initially leading to higher incidence of flooding and land-slides as per International 

Panel for Climate Change (IPCC 2001). 
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The discussion paper on Himalayan Glacier (Raina V.K. 2009) stated that smaller glaciers in 

the Himalayas having less than 5kms length exhibit an ice thickness of the order of 250m in 

the cirque region and ice thickness of the order of 40-60m along the middle regions though 

some larger glaciers like Zemu exhibit an ice thickness of over 200m in the middle region. 

From 1909 to 2005, Zemu glacier has retreated approximately 863meters. However the 

retreat was punctuated between 1988 and 2000 with an advancing of 92m (7.67 per year). 

The areal coverage of glacier increased during this period. In a nutshell, Zemu retreated 

between 1976-1988, advancing for 12 years (between 1988-2000) and again retreated 

thereafter. Therefore, one cannot correlate the impact of global warming on the glacier on the 

basis of these small term variations in Sikkim (MoEF Discussion Paper on Himalayan 

Glacier). 

Study of 57 glaciers in the Teesta basin between 1997 and 2004 from satellite imagery, shows 

that glaciers have a mean size of 7.15 km
2
 and the change in area is 0.36 km

2
 only (Kulkarni 

2010). 

Recent studies (Kulkarni 2010) by monitoring the Lhonak Lake of Teesta river basin using 

multi-year satellite data revealed that there is an increase of Lhonak Lake from 23 Hectares to 

110 Hectares from 1976 to 2007. This increase in lake area was caused by retreat and melting 

of glacier terminus (Kulkarni 2010). 

 Beat estimate for areal extent of glaciers in the Indian Himalaya is 25,041±1726 km
2 

(Kulkarni and Karyakarte 2014). In the Himalaya, the glacier covered area is approximately 

60,054 km
2 

(Bajracharya and Shresta, 2011). The estimated total glacier water stored in 

Indian Himalaya is 3600 to 4400 Gt (Kulkarni and Karyakarte 2014). 

Many research studies have revealed that around 70–80% of Himalayan glaciers are debris-

covered and have been retreating almost since the end of the Little Ice Age (Bhambri, Bolch, 

and Chaujar 2011; Bolch et al. 2012; Immerzeel, Pellicciotti, and Bierkens 2013; Way, Bell, 

and Barrand 2015; Earl and Gardner 2016). The long-term retreat of 81 glaciers, where 

position of terminus is measured using field data, suggests mean retreat of 621±468 m 

between year 1960 to 2000 (Kulkarni and Karyakarte 2014). 

The loss in area is almost 11,000 km
2
 in the Himalayan. The studies suggest almost 4-30% 

overall loss in glacier area in the last 40 years, depending upon numerous terrain and 

geomorphological parameters. The field and satellite based investigations suggest that most 
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of the glaciers in the Himalaya are retreating except in Karakoram (Tobias et al., 2012; 

Scherler et al., 2011). 

Glaciers in Caucasus mountain have retreated from 700 to 3000 m in the last 100 years, that 

is, average rate of retreat of 30m per annum. (Mikhalenko 1997). Investigations in the Baspa 

basin in India have shown an overall 19% deglaciation from 1962 to 2001 (Kulkarni and 

Alex 2003). Investigations carried out in the Himalayas suggests that almost all glaciers are 

retreating and the annual rate of retreat varies from 16 to 35 m (Dobhal et al. 2004; Oberoi et 

al. 2001). 

Himalayan glaciers have been in a state of general retreat since 1850 (Mayewski & Jeschke 

1979) and recent publications confirm that, for many, the rate of retreat is accelerating. 

Jangpang and Vohra (1962), Kurien and Munshi (1972), Srikanta and Pandi (1972), Vohra 

(1981), and many others have made significant studies on the glacier snout fluctuation of the 

Himalayan glaciers. But a dramatic increase in the rate seems to have occurred in last three 

decades. In 1998, researchers LA Owen and MC Sharma showed, by studying the 

longitudinal profiles of the river, that between 1971 and 1996, the Gangotri Glacier had 

retreated by about 850 m. This would yield a post-1971 retreat rate of 34 m a year. For the 

post-1971 period, the 61-year (19351996) data of GSI too shows that the retreat rate is about 

28 m/year, indicating a clear increase in the rate after 1971. 

Glaciers covering an area of 200 km
2
 in the Tista basin, Sikkim, Eastern Indian Himalaya, 

between 1990 and 2010 using Landsat Thematic Mapper (TM) and Indian Remote-sensing 

Satellite (IRS) images and related the changes to debris cover, supraglacial lakes and 

moraine-dam lakes. The glaciers lost an area of 3.3±0.8% between 1989/90 and 2010. More 

detailed analysis revealed an area loss of 2.0±0.82, 2.5±0.61 and 2.2±2.01 km
2
 for the periods 

1989–97, 1997–2004/05 and 2004–2009/10, respectively. This indicates an accelerated 

retreat of glaciers after 1997. 

2.4 Methods used for glacier studies 

Different glacier mapping methods with Landsat Thematic Mapper (TM) have been 

developed. A down scaling approach is carried out by comparing the TM derived glacier size 

with results from higher resolution data sets for absolute accuracy.There are various methods 

using remote sensing and GIS. 
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Images of Landsat and IRS_LISS (III) were utilized and the processes were carried out using 

ENVI 4.0 software .The image of IRS_LISS could not be used for snow mapping due to the 

fact that its spectral bands were not appropriate for this application. By using the images of 

Landsat, the boundary between snowy zones and no-snowy zones was distinguished.             

(N Roshani et al 2008). 

Glacier mapping and monitoring based on spectral data. Objective of this method is image 

segmentation and classification of mono- and multispectral data for mapping glacier outlines 

and glacier zones, spectral detection of changes in glacier boundaries and zones over time 

using multitemporal data, geometric detection of ice displacements (ice flow) using repeat 

data.  

The scheduling of ASTER image acquisitions is based on requests from researchers; areas 

selected by the ASTER Science Team for continual monitoring due to potential surface 

changes; and the goal of obtaining a one-time coverage of the entire land surface of the 

planet. For this research, two suitable ASTER Level 1A scenes were obtained from the 

NASA Land Processes Distributed Active Archive Centerin Sioux Falls, SD: one from 

September 2001 and another from October 2002.The 2001 scene was used for digitizing 

glacier outlines, and the 2002 scene, which was more cloud-free and showed greater contrast 

for snow and ice surfaces, was used for the DEM extraction (Khalsa et al 2004). 

Manual delineation Cursor tracking of glacier outlines was applied especially to Landsat 

MSS data in combination with false colour composites from Landsat TM of other years. 

Especially length changes were derived and compared with in-situ measurements (Hall et al. 

1992, Williams et al. 1997). Manual delineation was also used from Rott and Markl (1989) 

for individual glaciers in the Otztaler Alps in Austria. For a larger number of glaciers this 

method is too laborious. 

Segmentation of ratio images method was used in various combinations. Ratio images of the 

raw digital numbers (DN) from TM channel 4 (TM4) and TM5 were thresholded to obtain a 

glacier mask from Bayr et al. (1994). The planetary reflectance at the satellite sensor is 

treated by Hall et al. (1988) to depict different ice and snow facies within a glacier. Rott 

(1994) and Jacobs et al. (1997) used atmospherically corrected spectral reflectance images 

with TM3 / TM5 and TM4 / TM5, respectively, to obtain a glacier mask after thresholding. 
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An unsupervised ISODATA clustering with TM channels 1, 4 and 5 was performed by Aniya 

et al. (1996) for classification of the entire South Patagonian Icefield. A supervised 

Maximum-Likelihood classification is applied to Landsat MSS and TM scenes with support 

of a GIS by Gratton et al. (1990). Although high accuracy is achieved for most classes, 

regions with debris cover had to be classified by visual inspection. An evaluation of different 

ice and snow mapping methods was carried out by Sidjak and Wheat (1999). The best results 

were achieved by applying a supervised Maximum- Likelihood classification to a 

combination of various input bands with a TM4 / TM5 ratio image, a normalized difference 

snow index (NDSI), and the components 2-4 from a principal component analysis (PCA). 
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CHAPTER 3 

STUDY AREA 

3.1 Introduction 

In the present study the focus is on Sikkim Himalaya where many debris-covered glaciers are 

present. Sikkim is a part of the Eastern Indian Himalayan ranges and lies between Nepal and 

Bhutan .It is a mountainous state of India, extending114km from north to south and 64km 

from east to west, with a total geographical area of 7096 km
2
. The state is situated between 

27º00ʹ46ʺ and 28º07ʹ48ʺN and 88º00ʹ58ʺ and 88º55ʹ25ʺ E. The mountainous topography 

ranging from 300 to 8598m a.s.l (Basnett et al 2013), covering subtropical to alpine Eco 

zones, within a short horizontal distance. The state receives an annual precipitation of 2000–

4000mm (http://www.sikkimipr.org), while the Asian monsoon contributes >80% of 

precipitation during the summer months (Bookhagenand Burbank, 2010). Most of the 

geographical area of Sikkim is drained by the Tista River, a tributary of the Brahmaputra 

River. 

The state of Sikkim in the midst of the Eastern Indian Himalayan Region is surrounded by the 

snow-clad mountains of Nepal, China and Bhutan (Figure 1). The state has a large 

concentration of glaciers and permanent snowfields. Melt water from these glaciers forms an 

important source of water. The Tista River entirely traverses the state from North to South 

with the river forming the state‟s catchment area.  

Figure 3.1: Location map of Sikkim and two sub basins. 
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The river influences the life pattern and economy of the Sikkimese and parts of West Bengal 

and Bangladesh (Mukhopadya, 1982). Irrigation, hydel power and adventure tourism depend 

highly on the meltdown from the seasonal snow cover. Besides replenishing the streams that 

feed the Perennial river system of the Brahmaputra, the meltdown represents a major source 

of water, which is released during the spring-melt period. The rate of snowmelt holds critical 

information for flood forecasting, agriculture and optimal management of water resources .In 

terms of economy, the basin is important because of hydroelectric power projects. Sikkim in 

the Himalayas, has a unique pattern of snow precipitation which occurs almost throughout the 

year, unlike any other Himalayan regions. This challenges new work in this field. Moreover 

the lack of field data, uncertain precipitation patterns, indefinite accumulation and ablation 

seasons leave much scope to study the intrinsic climatic pattern and derive reasonable 

techniques for mass balance study. Since little or no work has been done on glacier studies, 

knowledge of the changes in glacial extent and snow cover patterns are important to assess 

future changes in stream run-off. In recent years spanning the last century there has been 

much emphasis laid on the changing dimensions of glaciers worldwide due to the impact of 

global warming on the snow accumulation and the melting rates of glaciers.  Several studies 

in the Himalayas, too, have indicated the loss in area of glaciers over a period of time. An 

investigation carried out by the Intergovernmental Panel on Climate Change (IPCC) has 

concluded that the Earth's average temperature has increased by 0.6 ± 0.2ºC in the 20th 

century. Various reports suggest that a significant number of mountain glaciers are shrinking 

due to climatic variations. This will have a profound impact on snow accumulation, stream 

runoff patterns and the ablation rate in the Himalayas, as snow and glaciers are sensitive to 

global climate changes. In the Indian Himalayas, the glaciers cover approximately 23,000 

km
2
. area and this is one of the largest concentrations of glacier-stored water other than the 

Polar Regions (Kulkarni et al., 2005). However, this source of water is not permanent as 

glacial dimensions change with the climate. Glacial changes can also be further accelerated 

due to man-made changes in the earth‟s environment.  

3.2 Climate 

The climate of Sikkim is divided into sub- tropical, temperate, and alpine zones from south to 

north with respect to altitude variation. Sprawled in an area of 7,096 km², Sikkim lengthens 

from an altitude of 280 m (920 ft.) to 8,585 m (28,000 ft.). With such varied altitudes, the 

state observes tropical, temperate and frigid climate in different regions. In the southern part, 
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the weather is usually sub-tropical, whereas in the north, it is generally tundra. Cold and 

humid climate is observed even in summers due to proximity of the state to the Bay of 

Bengal. The state receives heavy rainfall but the rainfall in the north district is comparatively 

less than in the other districts. The climate of Sikkim can be termed as temperate in broad 

terms. However, the colonized regions are dominated by temperate climate, where 

temperature rarely goes 28 °C maximum in summers and drops below 0°C in winters. The 

average annual temperature for the major part of Sikkim is recorded 18°C (64 °F) approx. 

The weather remains wintry and humid, since it rains most of the time. Monsoon prevails 

from late-June to early-September. During Monsoons, landslide is a common sight all the 

way through Sikkim. The annual rainfall varies from around 100mm to 3500mm with an 

average annual rainfall of around 2500 mm depending upon the altitude and aspects of 

slopes. The mean annual rainfall is minimum at Thangu (82mm) and maximum in Gangtok 

(3494mm). Based on the rainfall distribution pattern, there are two maximum rainfall area (i) 

south-east quadrant, including Manghak, Singhik, Dikchu, Gangtok and Rangoli and (ii) 

South west corner including Hilley. Namchilies in between these two regions; it receives 

about half of the rainfall received by the other two areas. Rainfall is heavy and well 

distributed during the months from May to early October. July is the wettest month among 

most of the places. The intensity of rainfall during the southwest monsoon season decreases 

from south to north. 

3.3 Geomorphology and Geology 

The Sikkim Himalaya comprises of the Lesser Himalaya, Higher Himalayan, and the Tibetan  

Tethys Himalayan zones .Distinct micro-morphological features of Sikkim terrain include 

terraces and floodplains, valley-side slopes and landslides slopes , alluvial cones of different 

types and generations ,v tors, kettle shaped depressions, sickle shaped rags, undulating plains 

with deeply dissected valleys, glacial or periglacial deposits, , related sedimentary structures, 

crevasses, soil series and gorges, etc. The terrain also exhibits various climatically induced 

landform suites, and the landform assemblages containing relict elements in the profiles 

arising from the time lag in response to varied geomorphic and pedogenic processes and 

environmental changes. 

Geological structure also pertly controls the physical configuration of the region. 

Precambrian rock of crystalline variety covers the eastern, northern, and western portions of 

the state. The rock types in the study area are the garnetiferous-banded biotite gneisses and 
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augen gneisses with occasional bands of amphibolite‟s and pegmatite veins. The banded 

augen-gneisses are found to high percentage of quartzo feldspathic materials near the contact 

zone. The individual bands are less than a meter to more than 50 meters thick. The rock in 

general is a medium grain to coarse grain leucocratic granitoid. The size of quartz and 

feldspar in augen gneiss varies with elevation in the study area. At lower belts schistose rocks 

are observed and they have undergone folding and physical weathering due to orogenesis. 

The rocks encountered at glaciers snout are gneiss and quartzite and due to physical 

weathering the rocks are fractured and jointed and disintegration to blocks which are on the 

verge of mobilization. At places due to the weathering process of frost and throw, rocks are 

cemented to boulders and debris. 

3.4 Natural Resources  

Sikkim has many resources like water resources, human resources, livestock resources, 

tourism, agriculture, horticulture, forest, minerals etc.  

3.4.1 Forest Resources 

Forests are one of the important resources of the state. Around 36% of the state is covered by 

forests. The forests supply fuel wood, fodder for livestock, wild edible plants, and timber and 

are source of income. The entire Himalayan region is endowed with flora and fauna. There 

are 4000 species of flowering plants, 300 species of ferns and its allies, 11 species of oaks, 8 

species of tree ferns, 30 to 40 species of Primulas, and 20 species of Bamboos. Many 

medicinal plant and important shrubs are found in the low and high altitude areas. State is 

very rich in fauna. There are 144 species of mammals, 500 to 600 hundred species of birds 

and many other species. 

3.4.2 Farming 

The north district is mainly dominated by large cardamom farming. The east, south and west 

district together are dominated by maize and potato farming in the higher elevation and 

paddy, ginger, mandarin, oranges, and wheat at lower elevations. The large cardamom 

farming and maize-potato farming systems dominated area account for nearly 60% of the 

total cultivated land. The farming system is fast changing towards high value cash crops like 

vegetables, fruits and pulses. 
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3.4.3 Hydropower and Mineral Resources 

Being a mountainous, snow and ice laden terrain, Sikkim has a vast potential for 

hydroelectric power generation. Most of the constructed hydroelectric power is micro-

hydroelectric power. 

The state mineral resources are sand, boulders, copper, iron, lime, dolomite, limestone, coal, 

quartzite and talc, silicate and graphite at various places (Mool and Bajracharya,2003). 

3.5 Demographic features and Economic profile 

3.5.1 Demographic Features 

The population of Sikkim is broadly divided into four ethnic groups, i.e. Lepchas, Bhutias, 

Sherpas, and Nepalese. The Lepchas are the original inhabitants of the state. The Bhutias 

comprises of the Sikkimese Bhutia and Bhutia from Bhutan and Tibet. The Sherpas are a 

marginal ethnic group in the state. The people from the plains, mostly involved in trade and 

services, represent a marginal group. Nepalese, comprising of over 70% of the population, 

are the dominant ethnic group in the state. The people from the plains, mostly involved in 

trade and services, represent a marginal group. 

As per the 2001 census of India, the total population of the state is 540,493. The overall 

population density is 76 per sq. km and is least populated (257 per sq. km) whereas the 

density in the north is only 10 per sq. km and is least populated. The population of the state 

has grown by 32.98% between 1991-2001, as against 21.34% for the country as a whole. The 

sec ratio of population was recorded as 875, which has declined from 878 in the previous 

census. The total literacy the state rose to 69.68% from 56.94% in the 1991 census (Mool and 

Bajracharya, 2003). 

3.5.2 Economic Profile 

About 11% land area is under agriculture and 65% of the total population is involved in 

agriculture. Animal husbandry is also an integral part of the household economy of the 

region. There are certain household industries which substantially add to the incomes. 

Besides agriculture and animal husbandry, the inhabitants in the city area are engaged in 

other jobs like government services ( Mool and Bjaracharya,2003). 
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CHAPTER 4 

DATA SOURCES 

4.1 LANDSAT 7 

The Landsat 7 satellite was successfully launched from Vandenberg Air Force Base on April 

15, 1999. The Delta II launch vehicle left the pad at 11:32 PDT and performed flawlessly. 

The injected spacecraft is a 5000 pound class satellite designed for a 705 km, sun 

synchronous, earth mapping orbit with a 16-day repeat cycle. 

The Landsat Program has provided over 38 years of calibrated high spatial resolution data of 

the Earth's surface to a broad and varied user community, including agribusiness, global 

change researchers, academia, state and local governments, commercial users, military, and 

the international community. Landsat images provide information meeting the broad and 

diverse needs of business, science, education, government, and national security. The mission 

of the Landsat Program is to provide repetitive acquisition of high-resolution multispectral 

data of the Earth's surface on a global basis. Landsat represents the only source of global, 

calibrated, high spatial resolution measurements of the Earth's surface that can be compared 

to previous data records. The data from the Landsat spacecraft constitute the longest record of 

the Earth's continental surfaces as seen from space. It is a record unmatched in quality, detail, 

coverage, and value. 

The Landsat platforms carry multiple remote sensor systems and data relay systems along 

with attitude-control and orbit-adjust subsystems, power supply, receivers for ground station 

commands and transmitters to send the data to ground receiving stations. The most recent 

Landsat mission, Landsat 7, offers these features: 

Data Continuity: Landsat 7 is a continuous series of land remote sensing satellites spanning 

38 years. 

Global Survey Mission: Landsat 7 data will be acquired systematically to build and 

periodically refresh a global archive of sun-lit, substantially cloud-free images of the Earth's 

landmass. 

Affordable Data Products: Landsat 7 data products will be available through the EROS 

Data Centre at the cost of fulfilling user requests (COFUR).  
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Enhanced Calibration: Data from the ETM+ will be calibrated to better than 5% absolute, 

providing an on-orbit standard for other missions.     

Responsive Delivery: Automated request processing systems will provide products 

electronically within 48 hours of order. 

The purpose of the Landsat program is to provide the world's scientists and application 

engineers with a continuing stream of remote sensing data for monitoring and managing the 

Earth's resources. Landsat 7 is the NASA satellite in a series that has produced an 

uninterrupted multispectral record of the Earth's land surface since 1972. Along with data 

acquisition and the USGS archival and distribution systems, the program includes the data 

processing techniques required to render the Landsat 7 data into a scientifically useful form. 

Special emphasis has been placed on periodically refreshing the global data archive, 

maintaining an accurate instrument calibration, providing data at reasonable prices, and 

creating a public domain level one processing system that creates high level products of 

superior quality.  

Landsat Data is available for FREE at Glovis: http://glovis.usgs.gov/ and Earth Explorer: 

http://edcsns17.cr.usgs.gov/EarthExplorer via USGS. 

 Overall Mission Objectives 

Landsat 7 is to have a design lifetime of five years. The overall objectives of the Landsat 7 

Mission are: 

 Provide data continuity with Landsats 4 and 5. 

 Offer 16-day repetitive Earth coverage. 

 Build and periodically refresh a global archive of Sun-lit, substantially cloud free, 

land images. 

 Make data widely available for the cost of fulfilling a user request (COFUR). 

 Support Government, international and commercial communities. 

 Play a vital role in NASA's Earth Observing System (EOS) by promoting 

interdisciplinary research via synergism with other EOS observations. (In particular, 

orbit in tandem with EOS-AM1 for near coincident observations.)  

http://glovis.usgs.gov/
http://edcsns17.cr.usgs.gov/EarthExplorer
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There are 8 bands in Landsat 7 which are used to record different colours with different 

wavelength and specific resolution. Most important bands of Landsat 7 for glacier mapping 

are Band 5, 4 and 3. The bands of Landsat 7 are as follows – 

BAND SPECTRAL 

WAVELENGTH (μm) 

 DESCRIPTION GROUND 

RESOLUTION 

BAND 1              .415-.515 BLUE       30m 

BAND 2              .525-.605 GREEN       30m 

BAND 3                .63-.69 RED       30m 

BAND 4                .75-.90 NEAR IR       30m 

BAND 5              1.55-1.75 SHORTWAVE IR       30m 

BAND 61 10.40-12.5( low gain TIR) THERMAL IR       60m 

BAND 62 10.40-12.5( high gain TIR) THERMAL IR       60m 

BAND 7             2.09-2.35 SHORTWAVE IR       30m 

BAND 8               .52-.90 PANCHROMATIC BAND       15m 

Table 4.1: Landsat 7 band properties. 

4.2 LANDSAT 8 

The Landsat Data Continuity Mission has a successful launch February 11th 2013. It was 

officially renamed to Landsat 8 on May 30, 2013. The newest satellite in the Landsat series 

offers scientists a clearer view with better spatial resolution than most ocean-sensing 

instruments and greater sensitivity to brightness and colour than previous Landsat‟s. Most 

significantly, it can observe the Earth in wavelengths that allows scientists to adjust for the 

distortions especially caused by the atmosphere near the coast.  

Landsat 8 carries two instruments: The Operational Land Imager (OLI) and Thermal Infrared 

Sensor (TIRS). The OLI, a push-broom sensor with a four mirror telescope, collects data in 

visible, near infrared, and shortwave infrared wavelength regions as well as a panchromatic 

band. Two new spectral bands have been added: a deep blue band for coastal water and 

aerosol studies (band 1), and a band for cirrus cloud detection (band 9). A Quality Assurance 

band is also included to indicate the presence of terrain shadowing, data artefacts, and clouds 

(USGS, 2013). Panchromatic, multispectral are taken in 15m, 30m resolution respectively. 

The TIRS collects data in two long wavelength thermal infrared bands. The 100meter spatial 

resolution of TIRS data is registered to the OLI data to create radiometrically and 

geometrically calibrated, terrain-corrected 16-bit Level 1 data products. 

Landsat 8 Operational Land Imager(OLI) and Thermal Infrared sensor(TIS) images consists 

of nine spectral band with a spatial resolution of 30m from band 1 to 7 and 9. New band 1 
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(ultra blue) is useful for coastal and aerosol studies. New band 9 is useful for cirrus cloud 

detection. The resolution for band 8 (panchromatic) is 15 metres. Thermal bands 10 and 11 

are useful in providing more accurate surface temperatures and are collected at 100 metres 

(resampled at 30 metres). Approximate scene size is 170km north-south by 183km east-west. 

Data collected by the instruments onboard the satellite, are available to download at no 

charge from GloVis, Earth Explorer, or via the Landsat Look Viewer within 24 hours of 

reception (USGS, 2013). Approximate scene size is 170 km north-south by 183 km east-west 

(106 mi by 114 mi) and have a large file size of about 1 GB compressed. The downloaded 

images are used further used for analysis of different features of earth. These images obtained 

from satellites are based on the reflectance properties of the objects present on earth. 

The level of detail (spatial resolution) is often the most interesting aspect of viewing a 

satellite image, but less appreciated is how changes in irradiative energy reflected by different 

surface materials are used to identify features of interest. Landsat 8 provides continuity to the 

previous sensors and also with its addition of new multispectral and thermal bands enables 

additional analysis in future. 

BAND SPECTRAL 

WAVELENGTH(μm) 

DESCRIPTION RESOLUTION 

BAND 1           .43-.45 COASTAL AEROSOL         30m 

BAND 2           .45-.51 BLUE         30m 

BAND 3           .53-.59 GREEN         30m 

BAND 4           .64-.67 RED         30m 

BAND 5           .85-.88 NEAR INFRARED 

(NIR) 

        30m 

BAND 6         1.57-1.65 SWIR 1         30m 

BAND 7         2.11-2.29 SWIR 2         30m 

BAND 8           .50-.68 PANCHROMATIC         15m 

BAND 9          1.36-1.38 CIRRUS         30m 

BAND 10       10.60-11.19 THERMAL IR 

1(TIRS1) 

        100m 

BAND 11       11.50-12.51 THERMAL IR 

2(TIRS2) 

        100m 

Table 4.2: Landsat 8 band properties. 
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4.3 Diva GIS  

DIVA-GIS is a free computer program for mapping and analysing spatial data. It is 

particularly useful for analysing the distribution of organisms to elucidate geographic and 

ecological patterns. DIVA-GIS supports vector (point, line, polygon), image and grid data 

types. It can help improve data quality by finding the coordinates of localities using 

gazetteers, and by checking existing coordinates using overlays (spatial queries) of the 

collection sites with administrative boundary databases. Distribution maps can then be made. 

Analytical functions in DIVA-GIS include mapping of richness and diversity (including 

based on molecular marker (DNA) data; mapping the distribution of specific traits; 

identifying areas with complementary diversity; and calculating spatial autocorrelation. 

DIVA-GIS can also extract climate data for all locations on land. 

It is used to obtain the shape file of Sikkim region for the analysis of the specific region. It 

helps in the calculation of area with help of shape file generate. It is very helpful in 

delineation and obtaining the boundary of any specific region. 

4.4 Temperature and Precipitation data from Indian Meteorological 

Department 

Since temperature and rainfall both have impact on the climate as well as glaciers. Annual 

average rainfall and annual average temperature is available on the site of IMD. Rainfall and 

temperature data from 1966-2000 has been obtained from the site of Indian Meteorological 

Department. India Meteorological Department (IMD) at present maintains around 550 

surface observatories in the country, where daily surface air temperature observations 

(maximum and minimum) are taken. These data are compiled, digitized, quality controlled 

and archived at the National Data Centre (NDC) of IMD. The data used is obtained by the 

IMD station situated in Gangtok. 
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CHAPTER 5 

METHODOLOGY 

5.1 ANALYSIS OF SATELLITE DATA 

Data was collected from the USGS system by the help of satellites namely Landsat8 and 

Landsat7 and was then analysed using ArcGIS 10.1. Steps involved in overall assessment of 

the glaciers are mentioned below. 

5.1.1 Data Collection  

Medium resolution satellite sensors such as LANDSAT allow extracting glacier outline using 

semi-automated algorithms at regional scales. Optical sensors detect solar radiation reflected 

by the earth‟s surface in the visible (VIS) and near infrared (NIR) bands of the 

electromagnetic spectrum (0.35 –2.5 µm).  Radiation emitted by the surface in the thermal 

infra‐ red (TIR) (8 – 14 µm) is  recorded as brightness temperature by the sensor. Due 

to its adequate spatio‐ temporal and spectral resolution, low cost and near‐ global coverage, 

LANDSAT is one of the most commonly used sensors for monitoring of Glacier parameters 

along with ASTER. 

Remote sensing data in the form of digital elevation model is freely available on the site of 

United States Geological Survey (USGS) and can be downloaded by selecting the co-

ordinates or by the name of the place. Select the time period from which date to which data is 

to be collected. 

Sources of the images or data obtained is LANDSAT 8 and LANDSAT 7, these images are 

downloaded with the help of USGS system. While downloading the image we should filter 

the data using months and the following three conditions should be satisfied- 

 Minimal Snow- Specify a time window at the end of the ablation season. 

 Minimal Clouds- Data to be downloaded should have cloud cover less than 10%. 

 Adequate contrast- Sensors saturate in the visible bands, so low gain settings in those 

bands are recommended. 

Images downloaded are in the form of different layers according to the bands of satellite and 

viewed with the help of Arc GIS. Information is extracted using the different tools present in 

the software. Image is downloaded is in .tiff format. 
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Data of the year 2005, 2006,2009,2011,2016 and 2017 is downloaded. Data of the year 2016 

and 2017 is from Landsat 8 whereas data of all other year is of Landsat 7. Data management 

is also an important part of the project; data should be saved with proper classification in 

different folders with their name. 

  

Figure5.1: Grayscale image of downloaded data from USGS(Landsat7 band 5 of 

04/12/2005). 

5.1.2 Adding data in ArcMap 

The data collected from the USGS system is saved with proper classification as per the need 

in different folders. Folder containing data contains different bands depending upon the 

satellite used; it could be LANDSAT 8 or LANDSAT 7. If the data obtained is from 

LANDSAT 7 then there would be 8 no. of bands and if it is LANDSAT 8 then number of 

bands would be 11. 

Most important band for Landsat 7 is Bands 5, 4, 3 and for Landsat 8 important bands are 

Band 6, 5, 4. The folder contains Landsat surface reflectance bands 1-11 and the metadata 

file. Each band is provided as 16-bit grayscale image. 

Launch Open a new empty ArcMap document and click the add button data at the menu. Add 

only bands which are the most important band 2 to 6 from the data folder. Then load band 4, 
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5, 6 on the arc map. Different ArcMap are launched for loading the data of all the different 

years. 

5.1.3 Creating False Colour Composites 

The display colour assignment for any band of a multispectral image can be done in an 

entirely arbitrary manner. In this case, the colour of a target in the displayed image does not 

have any resemblance to its actual colour. The resulting product is known as a false colour 

composite image. There are many possible schemes of producing false colour composite 

images. However, some scheme may be more suitable for detecting certain objects in the 

image. 

A very common false colour composite scheme for displaying a SPOT multispectral image is 

shown below:        

                                            R = XS3 (NIR band) 

                                            G = XS2 (red band) 

                                            B = XS1 (green band) 

This false colour composite scheme allows vegetation to be detected readily in the image. In 

this type of false colour composite images, vegetation appears in different shades of red 

depending on the types and conditions of the vegetation, since it has a high reflectance in the 

NIR band (as shown in the graph of spectral reflectance signature). 

Clear water appears dark-bluish (higher green band reflectance), while turbid water appears 

cyan (higher red reflectance due to sediments) compared to clear water. Bare soils, roads and 

buildings may appear in various shades of blue, yellow or grey; depending on their 

composition. False colour composites (FCC) are useful to get a look at the terrain. Colour 

composite of layer 654 is created. The “composite bands” tool in the Arc toolbox combines 

(stacks) the multiple bands into the single raster dataset. There is a stepwise procedure to 

create FCC in ArcGIS. 
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5.1.3.1 Steps performed for creating false colour composite 

Launch Arc toolbox then select Data Management → Raster → Raster Processing → 

Composite Bands. 

Input Raster: choose band 6 5 and 4 one by one for Landsat 8 and band 5 4 and 3 for Landsat 

7 in a sequence. 

Output Raster: FCC_654.tif and navigate to the folder and save it there, do not change the 

root name, so as to avoid any confusion later. 

For clouds add band 5 separately to the map and notice that clouds will be bright in this band 

this is because of spectral differences of clouds vs. ice/snow in near IR. The reflectivity of 

ice/snow drops in the NIR, while clouds are highly reflective in the near-IR. This is visible on 

band 5- ice/snow is black, and clouds are white. Band5 can be used to mask clouds using 

thresholds that need to be selected on each satellite image.  

 

                                        Figure5.2:  FCC of Sikkim of year 2005 
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5.1.4 Band Ratio Methods 

A band ratio is a new channel of data created by the division of two sets of band digital 

numbers for each pixel. It means dividing the pixels in one band by the corresponding pixels 

in a second band. The reason for this is twofold: One is that differences between the spectral 

reflectance curves of surface types can be brought out. The second is that illumination, and 

consequently radiance, may vary, the ratio between an illuminated and a not illuminated area 

of the same surface type will be the same. Thus, this will aid image interpretation, 

particularly the near-infrared/ red (NIR/R) band ratio. 

This creates a new set of data that may be used to highlight certain features. Logically, 

ratioing may cancel out or reduce whatever is common in two images and exaggerate where 

they are different. Advantage of band ratio is that it is fast, simple and robust. 

It also has some disadvantages, vegetation in shadow and turbid lakes may be partly 

classified as glaciers and it does not detect debris covered glaciers. 

5.1.4.1 Steps Performed for making band ratio 

In Arc Toolbox choose Spatial Analyst → Map Algebra → Raster Calculator. 

In Raster Calculator window, for Math algebra expression, choose the band by double 

clicking on them and then enter the operator “/” use the two bands. Because the input bands 

are integer data we have to multiply the first band by 1.0 to ensure that the calculation is done 

in floating point.  

In Environments set resolution to 30m. 

Name the output as bandratio_5_6.tif and save it in the folder named „band ratios‟ for the 

corresponding year. 

Add the resulting image to the table of contents. The image is a grayscale with snow and ice 

appearing as white.   
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Figure5.3: Band ratio image of Sikkim of year 2005 

5.1.5 Finding the threshold for ice and snow 

Using the “Identify tool” from the main menu and scroll around the image to look for the 

edges of the ice and snow (it is easily distinguished when we pass the threshold from bare 

land to the ice and values change sharply). 

Image thresholding: Image thresholding (also called as image segmentation) consists of 

dividing an image into segments with similar spectral or texture characteristics, which 

corresponds to real features. To find the threshold Identify tool is used and scrolled around 

the image to look for edges of the ice. Recommended values range from 1.2 to 2 (band ratio > 

1.5 to 2 = ice, image threshold is found by trial and error). R 

5.1.5 Steps performed for finding threshold 

In Arc Tool Box, choose Spatial Analyst → Map Algebra → Raster Calculator.  

To apply threshold, use the Raster Calculator with the expression: 
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         bandratio_5_6>= X.X, where X.X is the threshold achieved from sensitivity analysis. 

Set the output name as bandratio_5_6 trX.X.tif so as to keep the track of the different tests. 

The output is a binary image with (0) for non-ice and (1) for ice. Different thresholds were 

tried from 1.5 to 2 and were saved with different names. 

  

 

Figure5.4: Threshold image of Sikkim of year 2005  

5.1.6 Image Filtering  

Filters are defined as moving, overlapping neighbourhood statics, and are used to improve the 

quality of raster image by eliminating spurious data or enhancing the features in data.  

After delineation of ice and snow mass, filter is run to remove extraneous bits. Because while 

using band ratio method small lakes are also misclassified as ice, and filter help to remove 

these errors. 
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ArcGIS Spatial analyst provides two types of filters; low pass and high pass and both are 

based on focal functions with weighted kernel neighbourhoods. 

  A low pass filter smooth‟s the data by reducing local variation, and works by 

calculating the average (mean) value for each 3x3 neighbourhood with the Mean 

statistic type of the Focal Statistics function (or Focal Mean in Map Algebra). The 

effect is that the high and low values within each neighbourhood are averaged out. 

 A median filter gets rid of the smaller, misclassified cells and smooth‟s the data. 

5.1.6.1 Steps performed for image filtration 

Median filter with 3x3 kernel size is applied for the assessment. 

Go to Spatial Analyst → Neighbourhood → Focal Statistics  

Input raster: bandratio_5_6 trX.X.tif 

Output raster: bandratio_5_6 trX.Xmed3X3.tif 

Under the “statistics type” drop down menu choose “MEDIAN” and specify a 3x3 

neighbourhood with units as cell. 

In table of content right click on the filtered layer and export raster to save the final copy of 

the classification as ice.tiff.  

5.1.7 Raster to vector conversion 

In this step glacier rasters are converted to polygons so as to calculate the area of glaciers in 

the next step. These polygons can also be obtained directly with the data present on the 

GLIMS site but it‟s too complex as it gives the polygons of all the glaciers present on earth 

and hence area calculation for any specific area is very difficult. ArcGIS makes it simple to 

convert the raster into polygons and are easily obtained. 

5.1.7.1 Steps performed for vector conversion 

In Arc Tool Box, go to Conversion Tools → From Raster → Raster to Polygon. 

Select the best filtered result, med 3x3 is selected as input and output is specified as raster 

glaciers_2017_uned.shp and saved in the folder shapefile. Extension used for shape file is 

.shp. 
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The current file contains both the non-ice and ice, gridded by grid code 0 and 1. Polygons are 

edited further to remove the ice. From the main toolbar menu, Editor Toolbox is added and 

the newly created shape files are chosen for editing. 

 

     Figure5.5: Raster converted to polygons of year 2005. 

5.1.8 Extraction  

The Extraction tools allowed to extract a subset of cells from a raster by either the cells' 

attributes or their spatial location and also to obtain the cell values for specific locations as an 

attribute in a point feature class or as a table. 

The tools that extracted cell values based on their attribute or location to a new raster include 

the following: 

 Extracting cells by attribute value (Extract by Attributes) is accomplished through a 

where clause. 
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 Extracting cells by the geometry of their spatial location requires that groups of cells 

meeting a criteria of falling within or outside a specified geometric shape (Extract by 

Circle, Extract by Polygon, Extract by Rectangle). 

 Extracting cells by specific locations requires that you identify those locations either 

by their x,y point locations (Extract by Points) or through cells identified using a 

mask raster (Extract by Mask). 

In this step area required for assessment was extracted from the overall layer of the data 

collected from the satellite. In the thesis Sikkim Himalaya was the main point of focus so all 

the nearby area was removed with the help of extraction. Extraction by mask (Extracts the 

cells of a raster that correspond to the areas defined by a mask) was the method used. Mask 

file was downloaded from the IMD data in the form of shapefile for Sikkim region. 

Extraction was done for getting the extracts for FCC, band ratio, threshold, filter and polygon 

images. Raster obtained after the extraction was used in calculating the area of all the 

polygons present in the focussed region. Extraction is basically done for getting the desired 

area on which we have to perform the study. The data or satellite images obtained from 

USGS are of larger area and study to be done is for specified area . 

5.1.8.1 Steps performed for extraction 

In Arc Toolbox → Spatial Analyst Tool → Extraction → Extract by map. 

Input Raster:  bandratio_5_6 trX.Xmed3X3.tif 

Feature Mask Data: SikkimIMD.shp 

Output Raster: bandratio_5_6tr_extract.tif 

All these steps were performed to get the extracted raster‟s of all the images formed through 

various above mentioned steps. 
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Figure5.6: Extraction mask of Sikkim Himalaya region (source: IMD). 

5.1.9 Area Calculations 

Area is calculated from the polygons formed in the previous step. Area is calculated 

separately for all the years; 2005, 2006, 2009, 2011, 2016, and 2017. Calculation of area is 

the main objective of the work and then comparison is done on the basis of area change 

during these years. 

Area is calculated with the help of specific functions of ArcToolbox and used to calculate the 

area of all the polygons present in the Arc map. 

5.1.9.1 Steps performed for area calculation 

In Arc tool box → Utilities → Calculate area. 

Input Raster: glaciers_2017_uned.shp 

Output Raster: area_glaciers_2017.shp 
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Then right click on the newly generated area file, choose the option editor toolbox → start 

editing then go back and click on “open attribute table” and new dialog box will open with 

list of all the glaciers along with their glacier id and grid code. Grid codes are given as 0 and 

1, the one with zero need to be removed as they give the area which is not covered with 

snow.  

In attribute table select the option “select by attribute” and select “GRIDCODE” and write =0 

all the gridcode with 0 will be automatically selected and apply this editing feature and press 

“delete” all the glaciers with grid code 0 will be deleted. 

Export this attribute table to excel, in the form of text file and add the area of all the 

polygons. 

5.2 ANALYSIS OF METEOROLOGICAL DATA 

“Climate Change” in Intergovernmental Panel on Climate Change (IPCC 2007) context  

refers to a change in the state of the climate that can be identified (e.g. using statistical tests) 

by changes in the mean and/or the variability of its properties and that persists for an 

extended period, typically decades or longer. It refers to any change in climate over time, 

whether due to natural variability or as a result of human activity. As per United Nations 

Framework Convention on Climate Change (UNFCCC 1992) usage, it refers to change of 

climate that is attributed directly or indirectly to human activity that alters the composition of 

the global atmosphere and that is in addition to natural climate variability observed over 

comparable time periods. Meteorological data plays an important role in the formation and 

ablation of glaciers. Temperature and rainfall are the main factors responsible for the changes 

in glaciers. Global warming is the prime factor for the accelerated glacial melt and retreat, 

giving birth to hazardous glacial lakes in the Sikkim Himalayas.  

The climatic variability in recent decades has made considerable impacts on the glacier 

lifecycle in the Himalayan region.Many glaciers of the Sikkim Himalayas are leaving glacial 

lakes with increasing intensity, which in fact is corroborating with the intermediate effects of 

long term Climate Change by majority of scientists. Glacier thinning and retreat in the Sikkim 

Himalayas has resulted in the formation of new glacial lakes and  the enlargement of existing 

ones due to the accumulation of melt-water behind loosely consolidated end-moraine dams. 

Recent studies being carried out by Centre for Development of Advanced Computing (C-

DAC), Pune jointly with Sikkim State Council of Science & Technology, Gangtok, have 
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shown that many glacial lakes in Sikkim Himalayan region have grown over the years 

revealing the impact of climate change on glacial lakes and associated hazards. 

5.2.1 Steps performed for temperature and rainfall analysis 

Temperature and rainfall data has been obtained from the site of IMD for an annual average 

period that is 35 years from 1966-2000 and graph had been plotted observe the variation of 

rainfall and temperature during this period as these factors play very important role in the 

change of glacial area. 

5.2.1.1 Temperature Analysis 

Data from Indian Meteorological Department has been collected from year 1966 to 2000 and 

the change in average mean rainfall and average mean temperature has been observed with 

the help of graphs. A graph for every month and  year has been plotted for the years has been 

plotted for checking or analysing the change in annual mean rainfall and annual mean 

temperature. 

Figure 5.7 Temperature variation graph for January from 1966-2000. 

The minimum temperature was observed as 6.5ºC in the year 1983, while maximum was 

observed as 10.5ºC in the year 1999 and the average temperature during this period was 

8.41ºC. 
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Figure 5.8 Temperature variation graph for February from 1966-2000. 

The minimum temperature was observed as 6.75ºc in the year 1985; while maximum was 

observed as 14.55ºC in the year 1999 and the average temperature during this period was 

9.77ºC. 

 

Figure 5.9 Temperature variation graph for March 1966-2000. 

The minimum temperature was observed as 11.2ºC in the year 1990; while maximum was 

observed as 15.75ºC in the year 1999 and the average temperature during this period was 

13.51ºC. 
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Figure 5.10 Temperature variation graph for April from 1966-2000. 

The minimum temperature was observed as 13.5ºC in the year 1986; while maximum was 

observed as 18.75ºC in the year 1999 and the average temperature during this period was 

16.29ºC. 

Figure 5.11 Temperature variation graph for May from 1966-2000. 

The minimum temperature was observed as 16ºC in the year 1984; while maximum was 

observed as 19.45ºC in the year 1995 and the average temperature during this period was 

17.66ºC. 
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Figure 5.12 Temperature variation graph for June from 1966-2000. 

The minimum temperature was observed as 18ºC in the year 1977; while maximum was 

observed as 20.2ºC in the year 1998 and the average temperature during this period was 

19.14ºC. 

Figure 5.13 Temperature variation graph for July from 1966-2000. 

The minimum temperature was observed as 17.1ºC in the year 1986; while maximum was 

observed as 21.5ºC in the year 1998 and the average temperature during this period was 

19.39ºC. 
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Figure 5.14 Temperature variation graph for August from 1966-2000. 

The minimum temperature was observed as 17.9ºC in the year 1986; while maximum was 

observed as 20.1ºC in the year 1994 and the average temperature during this period was 

19.4ºC. 

Figure 5.15 Temperature variation graph for September from 1966-2000. 

The minimum temperature was observed as 16ºC in the year 1986; while maximum was 

observed as 19.4ºC in the year 1994 and the average temperature during this period was 

18.5ºC. 
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Figure 5.16 Temperature variation graph for October from 1966-2000. 

The minimum temperature was observed as 13.1ºC in the year 1986; while maximum was 

observed as 18.3ºC in the year 1998 and the average temperature during this period was 

16.6ºC. 

Figure 5.17 Temperature variation graph for November from 1966-2000. 

The minimum temperature was observed as 10ºC in the year 1985; while maximum was 

observed as 15.7ºC in the year 1998 and the average temperature during this period was 

13.2ºC. 
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Figure 5.18 Temperature variation graph for December from 1966-2000. 

The minimum temperature was observed as 7.5ºC in the year 1986; while maximum was 

observed as 12.5ºC in the year 1998 and the average temperature during this period was 10ºC. 

 

Figure 5.19 Annual average temperature variation graph from 1966-2000. 

The minimum temperature was observed as 12.9ºC in the year 1986; while maximum was 

observed as 16.4ºC in the year 1999 and the average temperature during this period was 

15.1ºC. 
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5.2.1.2 Rainfall Analysis 

Rainfall data for the years 1966 to 2000 have been downloaded from the Indian 

Meteorological Department (IMD) system. Graphs are plotted for all the different months and 

years separately for analysing the variation in the rainfall. 

Figure 5.20 Rainfall variation graph for January from 1966-2000. 

The minimum rainfall was observed as 0mm in the year 1969; while maximum was observed 

as 80.1mm in the year 1975 and the average rainfall during this period was 36.4mm. 

Figure 5.21 Rainfall variation graph for February from 1966-2000. 

The minimum rainfall was observed as 1.2mm in the year 1969; while maximum was 

observed as 507.6mm in the year 1975 and the average rainfall during this period was 

79.4mm.
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Figure 5.22 Rainfall variation graph for March from 1966-2000. 

The minimum rainfall was observed as 4.3mm in the year 1979; while maximum was 

observed as 263.9mm in the year 1968 and the average rainfall during this period was 

122.1mm. 

 

Figure 5.23 Rainfall variation graph for April from 1966-2000. 

The minimum rainfall was observed as 81.5mm in the year 1989; while maximum was 

observed as 504.8mm in the year 1999 and the average rainfall during this period was 

270.9mm. 
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Figure 5.24 Rainfall variation graph for May from 1966-2000. 

The minimum rainfall was observed as 309.6mm in the year 1970; while maximum was 

observed as 906.7mm in the year 1983 and the average rainfall during this period was 

527.6mm. 

 

Figure 5.26 Rainfall variation graph for June from 1966-2000. 

The minimum rainfall was observed as 299.3mm in the year 2000; while maximum was 

observed as 1281.2mm in the year 1997 and the average rainfall during this period was 

611.29mm. 
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Figure 5.27 Rainfall variation graph for July from 1966-2000. 

The minimum rainfall was observed as 380.9mm in the year 1984; while maximum was 

observed as 788.5mm in the year 1967 and the average rainfall during this period was 

628.47mm. 

 

Figure 5.28 Rainfall variation graph for August from 1966-2000. 

The minimum rainfall was observed as 239.7mm in the year 1996; while maximum was 

observed as 1088.2mm in the year 1984 and the average rainfall during this period was 

563.21mm. 
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Figure 5.29 Rainfall variation graph for September from 1966-2000. 

The minimum rainfall was observed as 188 mm in the year 1996; while maximum was 

observed as 848.3mm in the year 1970 and the average rainfall during this period was 

463.3mm. 

 

Figure 5.30 Rainfall variation graph for October from 1966-2000. 

The minimum rainfall was observed as 17.3 mm in the year 1970; while maximum was 

observed as 488 mm in the year 1996 and the average rainfall during this period was 

177.8mm. 
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Figure 5.31 Rainfall variation graph for November from 1966-2000. 

The minimum rainfall was observed as 0.2 mm in the year 1996; while maximum was 

observed as 173.5 mm in the year 1995 and the average rainfall during this period was 

41.6mm. 

 

Figure 5.32 Rainfall variation graph for December from 1966-2000. 

The minimum rainfall was observed as 0 mm in the year 1968; while maximum was observed 

as 83.8 mm in the year 1977 and the average rainfall during this period was 21.1mm. 
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Figure 5.33 Annual average rainfall variation graph from 1966-2000. 

The minimum rainfall was observed as 197 mm in the year 2000; while maximum was 

observed as 353.6 mm in the year 1974 and the average rainfall during this period was 269.2 

mm. 
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CHAPTER 6 

RESULTS AND DISCUSSIONS 

This study highlights the assessment of snow and glacier cover for possible inferences of 

global climate change impacts in high mountains like the Himalaya. The study has been done 

with the help of remote sending data obtained from Landsat Thematic Mapper and Indian 

Remote Sensing (IRS) satellite images. Data has been obtained from USGS (United States 

Geological Survey) system named Earth explorer for the year 2005, 2006, 2009, 2011, 2016 

and 2017. Area for all the years has been calculated by performing various tasks in ArcGIS. 

The total glacier area was observed as 578.32 km
2
 in 2005, 577.99 Km

2 
in 2006, 576.81 km

2
 

in 2009, 575.23 km
2 

in 2011, 571.33 km
2 

in 2016 and 568.66 km
2 

in 2017. With the area 

calculated for all the years it is observed that with the passage of time area of glaciers in the 

Sikkim Himalaya region is continuously decreasing. The areal coverage of glaciers has 

reduced during period 2005 to 2017. The overall area of glacier in the Sikkim region was 

569±39 km
2
 as reported by Racoviteanu et al.(2015) and the area in 2017 is 568.66 km

2
. The 

percentage change in the area is 0.44 % during 2015 to 2017 whereas the overall change in 

the area of glaciers from 2005 to 2017 is 1.67%. Glaciers are reducing in size year by year 

because the falling snow is not able to replace the amount of melting ice. Since glaciers are 

one of the most reliable climate indicators which indicated the change in the climate could be 

due to anthropogenic activities.  

                       YEAR                  GLACIER AREA (km
2
) 

                        2005                       578.32 
 

                        2006                        577.99 
 

                        2009                       576.81
 

                        2011                       575.23 
 

                        2016                       571.33 
 

                        2017                       568.66 
 

Table 6.1 Area calculated from 2005 to 2017 

Glaciers are the coolers of the planet earth and the lifeline of many of the world‟s major 

rivers. The number of glaciers has increased but decrease in the total glacier area has been 

observed.  
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CHAPTER 7 

CONCLUSION 

Area of Sikkim Himalayan glaciers was calculated for years 2005, 2006, 2009, 2011, 2016 

and 2017.  Landsat data was used to carry out the study. Automatic delineation methods were 

used to derive the results. As per the results of the study, the region has shown to have lost 

1.67% of area from 2005 till 2017. Results calculated might vary with actual situation of 

depletion of area. The variations might occur as per resolution problem in data, presence of 

debris cover over glaciers (which could not be classified very efficiently), cloud cover, etc. 

Since temperature and rainfall plays a very significant role in changing the climatic 

conditions and these climatic changes are responsible for retreat of glaciers. So, temperature 

and rainfall data taken from IMD website was analysed for years 1966-2000. The average 

value of temperature from 1966-2000 was found to be 15.1ºC whereas the average value of 

rainfall from 1966-2000 was found to be 269.22 mm. The observed value of temperature was 

found to be very less as compared to temperature values now days. „Industrial revolution‟ is 

mentioned as the main cause of this rise in average temperature in many researches done 

earlier. 

According to results given out by World Glacier Monitoring Service, the UN Environment 

programme declared that around the world glaciers are melting rapidly. Many recent research 

had revealed that the average rate of melting and thinning of ice had increased and it is 

definitely a major cause of concern for whole world. It has been observed in the research that 

glaciers have melted more than normal over the past centuries. The prime reason for this loss 

in area of glaciers is rapid industrialisation which in turn has caused global warming. Global 

warming is the prime culprit of fast melting of glaciers. 

Melting or decrease in the area of glaciers has many dangers as faster melting of glaciers will 

cause the stream and rivers to overflow and once the glaciers will totally melt the streams and 

rivers will run dry . Sea levels that have already risen due to warmer water will rise even 

further when all this water from melting glaciers empty in to the sea. 

This thesis is kind of warning for all of us to anyhow control the causes of global warming, 

so as to preserve the nature and control the adverse climatic changes in the atmosphere. 

Government as well as individuals should work at their levels to control pollution which is 

directly or indirectly responsible for global warming. 
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